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At Quectel, our aim is to provide timely and comprehensive services to our customers. If you 

require any assistance, please contact our headquarters: 

 

Quectel Wireless Solutions Co., Ltd.  

Building 5, Shanghai Business Park Phase III (Area B), No.1016 Tianlin Road, Minhang District, Shanghai 

200233, China  

Tel: +86 21 5108 6236  

Email: info@quectel.com 

 

Or our local offices. For more information, please visit:  

http://www.quectel.com/support/sales.htm. 

 

For technical support, or to report documentation errors, please visit:  

http://www.quectel.com/support/technical.htm. 

Or email us at: support@quectel.com. 

 

Legal Notices 
We offer information as a service to you. The provided information is based on your requirements and we 

make every effort to ensure its quality. You agree that you are responsible for using independent analysis 

and evaluation in designing intended products, and we provide reference designs for illustrative purposes 

only. Before using any hardware, software or service guided by this document, please read this notice 

carefully. Even though we employ commercially reasonable efforts to provide the best possible 

experience, you hereby acknowledge and agree that this document and related services hereunder are 

provided to you on an “as available” basis. We may revise or restate this document from time to time at 

our sole discretion without any prior notice to you. 

 

Use and Disclosure Restrictions 

License Agreements 

Documents and information provided by us shall be kept confidential, unless specific permission is 

granted. They shall not be accessed or used for any purpose except as expressly provided herein. 

 

Copyright 

Our and third-party products hereunder may contain copyrighted material. Such copyrighted material shall 

not be copied, reproduced, distributed, merged, published, translated, or modified without prior written 

consent. We and the third party have exclusive rights over copyrighted material. No license shall be 

granted or conveyed under any patents, copyrights, trademarks, or service mark rights. To avoid 

ambiguities, purchasing in any form cannot be deemed as granting a license other than the normal 

non-exclusive, royalty-free license to use the material. We reserve the right to take legal action for 

noncompliance with abovementioned requirements, unauthorized use, or other illegal or malicious use of 

the material. 

mailto:info@quectel.com
http://www.quectel.com/support/sales.htm
http://www.quectel.com/support/technical.htm
mailto:support@quectel.com
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Trademarks 

Except as otherwise set forth herein, nothing in this document shall be construed as conferring any rights 

to use any trademark, trade name or name, abbreviation, or counterfeit product thereof owned by Quectel 

or any third party in advertising, publicity, or other aspects. 

 

Third-Party Rights 

This document may refer to hardware, software and/or documentation owned by one or more third parties 

(“third-party materials”). Use of such third-party materials shall be governed by all restrictions and 

obligations applicable thereto. 

 

We make no warranty or representation, either express or implied, regarding the third-party materials, 

including but not limited to any implied or statutory, warranties of merchantability or fitness for a particular 

purpose, quiet enjoyment, system integration, information accuracy, and non-infringement of any 

third-party intellectual property rights with regard to the licensed technology or use thereof. Nothing herein 

constitutes a representation or warranty by us to either develop, enhance, modify, distribute, market, sell, 

offer for sale, or otherwise maintain production of any our products or any other hardware, software, 

device, tool, information, or product. We moreover disclaim any and all warranties arising from the course 

of dealing or usage of trade. 

 

Privacy Policy 
To implement module functionality, certain device data are uploaded to Quectel’s or third-party’s servers, 

including carriers, chipset suppliers or customer-designated servers. Quectel, strictly abiding by the 

relevant laws and regulations, shall retain, use, disclose or otherwise process relevant data for the 

purpose of performing the service only or as permitted by applicable laws. Before data interaction with 

third parties, please be informed of their privacy and data security policy. 

 

Disclaimer  
a) We acknowledge no liability for any injury or damage arising from the reliance upon the information. 

b) We shall bear no liability resulting from any inaccuracies or omissions, or from the use of the 

information contained herein.  

c) While we have made every effort to ensure that the functions and features under development are 

free from errors, it is possible that they could contain errors, inaccuracies, and omissions. Unless 

otherwise provided by valid agreement, we make no warranties of any kind, either implied or express, 

and exclude all liability for any loss or damage suffered in connection with the use of features and 

functions under development, to the maximum extent permitted by law, regardless of whether such 

loss or damage may have been foreseeable. 

d) We are not responsible for the accessibility, safety, accuracy, availability, legality, or completeness of 

information, advertising, commercial offers, products, services, and materials on third-party websites 

and third-party resources. 

Copyright © Quectel Wireless Solutions Co., Ltd. 2025. All rights reserved. 
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About the Document 

 

Revision History 

Version Date Description 

1.0 2020-01-03 Initial 

2.0 2023-05-23 

1. Updated the tool version to V1.8. 

2. Numerous changes were made to this document. It should be read in its 

entirety. 

3. Adjusted the scope of application from LC79D to all GNSS modules. 

2.1 2023-10-16 

1. Updated the tool version to V1.9. 

2. Added QuecRTK function (Chapter 1). 

3. Updated Deviation Map and related icons to show more detailed 

positioning information (Chapter 2.2.3.5). 

4. Added the “Calculation Distance” tool in the coordinate converter window 

(Chapter 2.2.5.3).  

5. Added QuecRTK Client and Data Monitor pages (Chapters 3.8.2 and 

3.8.3). 

6. Added the figure of firmware download process (Figure 50). 

2.2 2024-01-09 Updated the tool version to V1.10. 

3.0 2024-08-29 

1. Updated the tool version to V2.0. 

2. Numerous changes were made to this document. It should be read in its 

entirety. 

3.1 2025-04-17 1. Updated the tool version to V2.1. 

Document Information 

Title QGNSS User Guide 

Subtitle GNSS Module Series 

Document Type User Guide 

Document Status Released 
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Version Date Description 

2. Numerous changes were made to this document, including but not limited 

to optimizing interface icons, fixing internal defects. It should be read in its 

entirety. 

3.2 2025-07-01 

1. Updated the tool version to V2.2. 

2. Added descriptions of “Raw Data”, “Binary Data” and “Text Data” 

sub-windows (Chapters 2.2.3.1, 2.2.3.2 and 2.2.3.3). 

3. Added descriptions of “GNSS Coordinate Transformation” sub-Window 

(Chapter 2.2.5.2). 

4. Added descriptions of “Error Messages” (Chapter 2.2.5.6). 
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1 Introduction 
 

QGNSS is a tool that allows you to interact with Quectel GNSS modules quickly and easily. It enables 

evaluation, performance testing, development and debugging of Quectel GNSS modules. Tool features 

are listed below: 

 

⚫ Supports receivers utilizing standard NMEA strings in compliance with NMEA 0183 V4.11 and 

previous versions. 

⚫ Supports the parsing of RTCM3.x protocol messages. 

⚫ Supports log replay. 

⚫ Presents all the information collected by the GNSS device. All aspects of GNSS data (positioning, 

velocity, time, satellite tracking, etc.) can be monitored and logged under various test scenarios for 

receiver evaluation. 

⚫ Supports the downloading of AGNSS data. 

⚫ Supports NTRIP Client, Server and Caster. 

⚫ Supports the downloading of firmware update packet to GNSS modules.
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2 User Interface Description 
 

2.1. Main Window 

 

The figure illustrated below is the initial window of QGNSS. 

 

Figure 1: Main Window 

 

2.2. Menu Bar 

2.2.1. File Tab 

In the “File” tab menu: Click “Quit” to close QGNSS. 

 

Figure 2: File Tab 
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2.2.2. Device Tab 

In the “Device” tab menu: 

 

⚫ Click “Connect” to connect to the receiver. 

⚫ Click “Device Info” to configure serial port information. See Chapter 3.1 Connect to Receiver for 

details. 

 

Figure 3: Device Tab 

 

 

Make sure to configure the serial port information before connecting to the receiver. 

 

2.2.3. View Tab 

The main function of all sub-windows under “View” is to display key data. 

 

Figure 4: View Tab 

NOTE 
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2.2.3.1. Raw Data Sub-Window  

The “Raw Data” sub-window displays all data sent by the receiver. There are “Clear”, “Timestamp”, 

“Pause” button, and “Filter” at the bottom of the window. 

 

Figure 5: Raw Data Sub-Window  

 

2.2.3.2. Binary Data Sub-Window  

The “Binary Data” sub-window displays the message of the binary protocol. There are “Clear”, 

“Timestamp”, “Pause” button and “Filter” at the bottom of the window. 
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Figure 6: Binary Data Sub-Window 

 

2.2.3.3. Text Data Sub-Window  

The “Text Data” sub-window displays validated NMEA messages. There are “Clear”, “Timestamp”, 

“Pause” button and “Filter” at the bottom of the window. 

 

Figure 7: Text Data Sub-Window  
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2.2.3.4. Configuration View Sub-Window  

The “Configuration View” sub-window is used to modify the receiver configuration. The configuration 

parameters may change depending on module type. “Query” button is used for querying commands in 

the current page. “Setting” button is used for generating commands and sending them to the GNSS 

module. 

 

Figure 8: Configuration View Sub-Window 

 

2.2.3.5. Data View Sub-Window 

The “Data View” sub-window displays the data information, such as longitude, latitude, altitude, fix mode 

and mileage. 
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Figure 9: Data View Sub-Window 

 

2.2.3.6. Deviation Map Sub-Window 

The “Deviation Map” sub-window displays positions in longitude and latitude relative to the initial 

positioning point and show CEP circle. CEP (Circular Error Probable) is a metric used to measure the 

positioning accuracy. It uses a circle, centered on the reference point, to represent the distribution of 

positioning errors. Left click the   to display the CEP circle, as shown in Figure 11: Deviation Map 

Sub-Window – CEP. 
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Figure 10: Deviation Map Sub-Window – Gnd Trk 

 

Figure 11: Deviation Map Sub-Window – CEP 

 

The detailed functions of “Gnd Trk” page in “Deviation Map” sub-window are listed below: 

Table 1: Deviation Map Function Description 

Icon Description 

 Click the icon to display CEP circle 
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Icon Description 

N=624 Total points 

1:18(2.9%) GPS SPS Mode: 18 points in total (accounting for 2.9 % of the total points) 

2:1(0.2%) 
Differential GPS, SPS Mode or SBAS Mode: 1 point in total (accounting for 0.2 % of the 

total points) 

3:3(0.5%) GPS PPS Mode: 3 points in total (accounting for 0.5 % of the total points) 

4:569(91.2%) Fixed RTK Mode: 569 points in total (accounting for 91.2 % of the total points) 

5:30(4.8%) Float RTK Mode: 30 points in total (accounting for 4.8 % of the total points) 

6:3(0.5%) 
Estimated (dead reckoning) Mode: 3 points in total (accounting for 0.5 % of the total 

points) 

 

The “Setup” page enables you to specify the reference point type. Choosing “Average” under 

“Reference point” will automatically populate the longitude, latitude and altitude fields with their average 

values. On the other hand, selecting “User”, you will need to manually input the respective longitude, 

latitude and altitude values. 

 

Figure 12: Deviation Map Sub-Window – Setup 

 

1. Use the mouse scroll wheel to zoom in/out on the “Deviation Map” and hold down the left mouse 

button to drag the “Deviation Map”. Right click the mouse button to clear the points on the 

“Deviation Map”. 

NOTE 
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2. The color of the points in the deviation map are determined by the different values of <Quality> 

field in the GGA message. 

 

2.2.3.7. Dashboard View Sub-Window 

The “Dashboard View” sub-window is composed of four instrument panels, speed instrument panel, 

knots indicator, altitude instrument panel and heading instrument panel, which displays relevant data in 

the NMEA protocol. 

 

Figure 13: Dashboard View Sub-Window 

 

2.2.3.8. GNSS Signal View Sub-Window 

The sub-window in the figure below (“GNSS Signal View”) contains “Horizontal View” and “Vertical 

View”.  

 

1. Horizontal View Introduction 

 

“Horizontal View” displays GNSS signal view. The number above the flag represents the C/N0 value. You 

can use the checkbox to select the satellite system to be displayed. If the flag is transparent, it means that 

the receiver is not tracking this satellite and therefore there is no data available in NMEA GSA messages. 
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Figure 14: GNSS Signal View Sub-Window – Horizontal View  

 

Click “...” to display the detailed information and click "Band" to hide the detailed information. 

 

Figure 15: Horizontal View Detailed Information 

 

Table 2: GNSS Signal View Function Description 

Button Description 

Band Satellite frequency band. 

Code Sent by a satellite for ranging and satellite acquisition. 

PRN Pseudo Random Noise Code. 

Azim Satellite azimuth in degrees. 

Elev Satellite elevation in degrees. 
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2. Vertical View Introduction 

 

Click “Vertical View” to open the vertical satellite signal-to-noise ratio chart, which allows for a more 

intuitive comparison of the trends of satellite values among different constellations. 

 

Figure 16: GNSS Signal View Sub-Window – Vertical View 

 

2.2.3.9. IMU View Sub-Window 

The “IMU View” is composed of three curve charts, “IMU Output View”, “IMU1 Raw Data” and “IMU2 

Raw Data”, for a more intuitive display of the real-time data fluctuations. The presentation of those three 

curves is the same, yet the data sources are different. The “IMU Output View” is derived from calibrated 

IMU data, and the data sources for “IMU1 Raw Data” and “IMU2 Raw Data” are IMU1 raw data and IMU2 

raw data. By checking or unchecking the relevant checkbox, those curves can be displayed or hidden. 
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Figure 17: IMU View Drop-down Menu 

 

“IMU Output View” sub-window displays three-axis acceleration (ACC_X, ACC_Y, ACC_Z), three-axis 

angular rate (GYO_X, GYO_Y, GYO_Z), and Temperature, as well as the extreme and average values of 

these seven data in the form of curve charts. In addition, it also contains some user-friendly settings. 

 

Figure 18: IMU View Sub-Window 

 

The details on “IMU Output View” are listed below: 

 

⚫ Data Point: Range of a single curve in the curve chart, which can be set to 100, 300, 500, 1000, 

2000 or 3000. 

⚫ Reset Zoom: Curve state restoration button. After clicking the button, the curve will be restored to its 

original state. 
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⚫ Pause/Running Chart: Stop refreshing curve/refresh curve button. 

➢ After clicking “Pause Chart”, the button changes to “Running Chart”. At this time, the curve 

stops refreshing and interactive operations of the curve can be performed on the chart, such as 

viewing detailed data of a single point, moving and scaling the curve. 

➢ After clicking “Running Chart”, the button changes to “Pause Chart”. At this time, the curve is 

refreshing and the interactive operations of the curve is disabled. 

⚫ Minimum: Minimum value within the “Data Point” range. 

⚫ Average: Average value within the “Data Point” range. 

⚫ Maximum: Maximum value within the “Data Point” range. 

⚫ Stdev: Standard deviation within the “Data Point” range. 

 

Figure 19: IMU Curve Menu 

 

Figure 20: IMU Comparison 

Right click the mouse to open the curve menu, the details are as follows: 

 

⚫ Clear: Clear all current data of the curve chart. 

⚫ Refresh: The function is the same as “Reset Zoom”.  

⚫ Comparison: Check to open the point comparison view to show data points on the Y-axis that 

corresponds to the points on the X-axis. Parameters, taking data in the first row of Figure 20: IMU 

Comparison as an example, are explained as follows: 

➢ GYO_X: Curve name 

➢ Unix: Unix time, Unit: Second 
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➢ UTC: UTC time 

➢ V: Data points on the Y-axis that corresponds to the points on the X-axis 
 

 

If the IMU time is not synchronized with the time of GNSS module, Unix time and UTC time will be 

converted according to the IMU time instead of the actual time. 

 

2.2.3.10. Online Map Sub-Window 

The “Online Map” displays real-time location reported by the module on a map. 

 

Figure 21: Online Map Sub-Window 

 

2.2.3.11. Sky View Sub-Window  

The “Sky View” sub-window displays the azimuth and elevation angle (above the Horizon) of each visible 

navigation satellite per constellation and counts the number of all visible satellites of each positioning 

system. 

NOTE 
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Figure 22: Sky View Sub-Window 

 

2.2.4. Setting Tab 

Click “Preferences” in the dropdown menu of “Setting” to enter the “Preferences” sub-window and set 

the supported protocol to parse in the “Preferences” sub-window. 

  

Figure 23: Setting Tab 

   

Figure 24: Preferences Sub-Window 
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You can switch between the online maps supported by the QGNSS (“TianDiMap” and “OpenStreetMap”) 

via “Switch Online Map” dropdown menu. 

 

Figure 25: Switch Online Map 

 

2.2.5. Tools Tab 

The sub-windows in the “Tools” tab are illustrated below: 

 

Figure 26: Tools Tab 

 

2.2.5.1. AGNSS Sub-Window 

Assisted Global Navigation Satellite System (AGNSS) represents a sophisticated enhancement to 

conventional GNSS technology, specifically engineered to address its limitations. Typically, GNSS 

receivers experience extended first-time-to-fix (TTFF) durations, often reaching several tens of seconds 

post-startup, a process known as cold start, due to the limited speed at which satellites transmit 

navigation information. This delay is exacerbated in signal challenge environment. AGNSS technology 

mitigates this issue by facilitating the acquisition of assistance data via network. The assistance data 

encompasses ephemeris, almanac, accurate time and approximate position. Leveraging this data, 

AGNSS empowers receivers to swiftly calculate accurate positions within a few seconds, even under 

weak signal conditions. 

 

The QGNSS tool incorporates an AGNSS feature that enables the downloading of AGNSS data files from 

FTP server using two distinct approaches: “Online AGNSS” and “Offline AGNSS” data downloading. 

See Chapter 0  

Download AGNSS Data from Server for details. 
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2.2.5.2. Coordinate Converter Sub-Window 

1. In the “Coordinate Converter” Sub-Window: 

 

⚫ Select one of the “LLA(Deg)”, “LLA(Deg,Min)”, “LLA(Deg,Min,Sec)”, or “ECEF(XYZ)” coordinate 

system formats, taking “LLA(Deg)” as an example: 

  

Figure 27: Coordinate Converter Sub-Window – Enter Values 

 

⚫ Click “Convert” and the tool will convert the values to other formats. 
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Figure 28: Coordinate Converter Sub-Window – Convert Values 

 

2. In the “Finding Coordinate Distance” Sub-Window: 

 

⚫ Enter the latitude and longitude of starting and end points to calculate the straight-line distance 

between two points. 

 

Figure 29: Finding Coordinate Distance Sub-Window 
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3. In the “GNSS Coordinate Transformation” Sub-Window: 

 

⚫ Directly copy and paste the GNSS output coordinates (in DDMM.MMMMMM format) into the 

corresponding field to convert them to BD09, GCJ02, and Decimal Degree formats. 

 

Figure 30: GNSS Coordinate Transformation Sub-Window 

 

2.2.5.3. Firmware Update Sub-Window 

The “Firmware Update” sub-window is used to upgrade the module firmware. See Chapter 3.8 Firmware 

Update for the general process of firmware upgrade. If the detailed process of firmware upgrade via 

QGNSS for a specified module is required, please refer to the corresponding firmware upgrade guide. 
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Figure 31: Firmware Update Sub-Window 

 

2.2.5.4. NMEA2KML Sub-Window 

The “NMEA2KML” sub-window is used to convert the NMEA log to a KML format file. 

 

⚫ Click “Add NMEA” to select the NMEA file to be converted in the pop-up window. 

⚫ Click “Color” drop-down box to select the color of a point. 

⚫ Click “Generate” to convert the NMEA log to a KML format file. 

 

Figure 32: NMEA2KML Sub-Window 
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1. After checking "Auto-Open KML" the generated KML file can be directly opened with Google 

Earth.exe on your computer. 

2. After checking "Incl.Sat.Data," satellite data will be displayed at points in Google Earth. 

 

2.2.5.5. NTRIP Sub-Window 

See Chapter 3.7 Build NTRIP System for details. 

 

2.2.5.6. Console Sub-Window 

“Console” is a multi-functional sub-window that integrates “Com Tool”, “Protocol Package”, “Message 

Statistics”, “Error Messages” and ”Data Input”. 

 

Figure 33: Console Sub-Window 

 

 

 

 

 

 

 

 

 

 

NOTE 
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1. Com Tool Introduction 

 

The “Com Tool” is a debugging window for the module’s raw data. Right-click the mouse to pop up the 

context menu. 

 

Figure 34: Com Tool Context Menu 

 

 

Figure 35: Details on Com Tool Menu 
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The “Com Tool” context menu information is as follows: 

 

⚫ Show Tool: Set whether the left sidebar is visible. Shortcut: Ctrl+Q. 

⚫ Search: Regular match filtering and highlighting. Shortcut: Ctrl+F. 

⚫ Copy: Copy selected context. Shortcut: Ctrl+C. 

⚫ Select All: Select all current context in “Com Tool”. Shortcut: Ctrl+A. 

⚫ Clear: Clear current context. Shortcut: Ctrl+X. 

⚫ Pause: Control whether to pause data appending. Shortcut: Ctrl+P. 

⚫ Display: Control data display. 

➢ Auto Scroll: Control whether to enable automatic data scrolling. Shortcut: Ctrl+S. 

➢ Auto Warp: Control whether the data automatically wraps when it exceeds the window width. 

Shortcut: Ctrl+G. 

➢ Show Time: Control whether to display the timestamp. Shortcut: Ctrl+T. 

➢ Show RX: Control whether to display the received data. Shortcut: Ctrl+R. 

➢ Show TX: Control whether to display the sent data. Shortcut: Ctrl+O. 

➢ Plain Mode: Control whether to output raw data without adding any extra characters. Shortcut: 

Ctrl+L. 

➢ Monospace Font: Set the output font to the same width font. Shortcut: Ctrl+M. 

➢ Show Script Send Dialog: Control whether to display the script sending window. Shortcut: 

Ctrl+Shift+S. 

⚫ Format: Text encoding. 

➢ Bin: Binary encoding. 

➢ Hex: Hex encoding. 

➢ Ascii: ASCII encoding. 

 

Table 3: Description of Console Functions 

Icon Function Description 

 Search Regular match filtering and highlighting 

 Clear Clear current context 

 Pause Control whether to pause data appending 

 Auto Scroll Control whether to enable automatic data scrolling 

 Auto Warp 
Control whether the data automatically wraps when it exceeds 

the window width 

 Show Time Control whether to display the timestamp 

 Show RX Control whether to display the received data 

 Show TX Control whether to display the transmitted data 
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Icon Function Description 

 Plain Mode 
Control whether to output raw data without adding any extra 

characters 

 Show Script Send Dialog Control whether to display the script sending window 

 Send Data Click to send input data 

 Advance Configure the data parameters to be sent 

 Match Case Control whether to enable case matching 

 Enable Filter Control whether to enable filtering 

 Save File Control whether to save filtered data to a file 

 

Press the shortcut key “Ctrl+F” or click the  button to display the search box in the upper right corner. 

Enter the relevant content and click the  button under the search box to display the matched data in 

the new right box. 

 

Figure 36: Com Tool Data Filtering 

 

Click the  button in the left column of “Com Tool”, the “Script Send” window pops up. You can send 

one command at a time or enabled commands cyclically through this window, see Chapter 3.2.2 Script 

Send for details. Besides, the window also supports importing and exporting scripts. 
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Figure 37: Script Console 

 

Introduction on pop-up menu associated with the “Advance” button: 

 

⚫ Description: Input data description. Add this information to mark the purpose of the input data, which 

is useful when you open a previous script. 

⚫ Delay: Regulate the delay in milliseconds before the data is transmitted. 

⚫ Text format: Format of sent data, classified as: 

➢ Bin: Send binary data. 

➢ Hex: Send hexadecimal data. 

➢ Ascii: Send ASCII data. 

⚫ Checksum Type: Checksum types, classified as: 

➢ NONE: No checksum by default. 

➢ NMEA: Add NMEA checksum. 

➢ RTCM3: Add RTCM3 checksum. 

⚫ Suffix: Suffix information, classified as: 

➢ None: No suffix. 

➢ CR: Carriage return. Add suffix ‘\r’. 

➢ LF: Line feed. Add suffix ‘\n’. 

➢ CRLF: Carriage return line feed. Add suffix “\r\n”. 

➢ LFCR: Line feed carriage return. Add suffix “\n\r”. 

 

2. Protocol Package Introduction 

 

“Protocol Package” displays the parsed message. When the specific message on the left is selected, 

manually click on the right sidebar to support display of detailed message information. 
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Figure 38: Protocol Package 

 

Right-click the mouse and context menu pops up. 

 

⚫ Search: Regular match filtering. Shortcut: “Ctrl+F”. 

⚫ Clear: Clear current context. Shortcut: “Ctrl+X”. 

⚫ Auto Scroll: Control whether to enable automatic data scrolling. Shortcut: “Ctrl+S”. 

⚫ Column Visible: Control which columns are visible. 

➢ Index: Message index. 

➢ Time: Receiving time. 

➢ Protocol: Protocol type. 

➢ Type: Message type. 

➢ Ascii: ASCII encoding display. 

➢ HEX: Hexadecimal encoding display. 

➢ Size: Number of bytes. 

➢ Remark: Remark reserved for future use. 

 

3. Message Statistics Introduction 

 

“Message Statistics” perform statistics on parsed messages and record the received interval. Click the 

right column to display the details of the message. 
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Figure 39: Message Statistics 

 

4. Error Messages Introduction 

 

“Error Messages” perform statistics on error messages that occur during the parsing process, and record 

the types of errors. 

 

Figure 40: Error Messages 
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5. Data Input Introduction 

 

“Data Input” is multi-function data sending field. You can send one command at a time. Additional 

functions include historical data saving and deleting, as shown in figure below: 

 

Figure 41: Data Input 

 

2.2.5.7. GNSS Log Sub-Window 

The “GNSS Log” displays a line chart of satellite signal-to-noise ratio, number of visible satellites, and 

number of satellites in use, and presents satellite data in the NMEA message. 

 

Figure 42: GNSS Log Sub-Window 

 

There are “Plots” and “Signals” options on the right side of “GNSS Log”: 

 

⚫ “Plots” displays the current time, options of the three curve charts, i.e., satellite signal-to-noise ratio, 

number of visible satellites, and number of satellites in use, and the extremum and average values of 

the signal bands. 

⚫ “Signals” displays or hides the curves. 



 
                                                    GNSS Module Series 

 

QGNSS_User_Guide                                                                  40 / 68 
 
 
 

 

Figure 43: GNSS Log Right Tab 

 

Right-click to open the curve menu. 

 

⚫ Clear: Clear all current data related to curve charts. Shortcut: Ctrl+Del 

⚫ Refresh: Restore curve charts to their initial state. Shortcut: F5 

⚫ Comparison: Check to open the point comparison view to show data points on the Y-axis that 

correspond to the points on the X-axis. 

 

Figure 44: Curve Menu 
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Figure 45: GNSS Log Comparison 

 

2.2.6. Windows Tab 

In the “Windows” tab menu: 

 

⚫ Click “Cascade” to display the sub-window(s) in a cascade pattern. 

⚫ Click “Close All” to close all sub-windows. 

⚫ Click “Default Layout” to select three pre-set interface layouts. 

 

  

Figure 46: Window Tab 

 



 
                                                    GNSS Module Series 

 

QGNSS_User_Guide                                                                  42 / 68 
 
 
 

 

Figure 47: Default Layout Tab Menu 

 

Display all the sub-windows in a cascade pattern. 

 

Figure 48: Cascade Window 
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Closes all windows. 

  

Figure 49: Close All Windows 

 

The “Default Layout” has three basic interface layouts: 

 

Figure 50: Default Layout – Layout 1 
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Figure 51: Default Layout – Layout 2 

 

 

Figure 52: Default Layout – Layout 3 
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2.2.7. Help Tab 

 

Figure 53: Help Tab 

 

2.2.7.1. About Sub-window 

Display QGNSS version and component version and compile time. 

 

Figure 54: About Sub-Window 

 

2.2.7.2. License Sub-Window 

1. Generate registration code: Enter the username and email address and click the "Generate 

Registration Code" button to generate the registration code. The folder where the registration code 

is generated automatically opens. 

2. Import license management and control function: Click “Select License” to obtain a license. Then 

reopen the software to load functions according to permissions. 
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Figure 55: License Sub-Window  

 

2.3. Tool Bar 

 

Tool bar can be used for quick access to common operations. 

 

Figure 56: Tool Bar 

 

Table 4: Description of Tool Bar Functions 

Icon Function Description 

 Connect Connect/disconnect serial port 

 Set Device Information Select module and set serial parameter(s) 

 Show Logfile in Explorer Open the folder containing the saved log file(s) 

 Cold Start Send a cold start command 

 Hot Start Send a hot start command 



 
                                                    GNSS Module Series 

 

QGNSS_User_Guide                                                                  47 / 68 
 
 
 

Icon Function Description 

 Warm Start Send a warm start command 

 Full Cold Start Send a full cold start command 

 
Reboot Send reboot command 

 
Log Recording Mode Open the log recording mode 

 GNSS Signal View Open the “GNSS Signal View” sub-window 

 Online Map Open the “Online Map” sub-window 

 Sky View Open the “Sky View” sub-window 

 Deviation Map Open the “Deviation map” sub-window 

 
NTRIP Client Open the “NTRIP Client” sub-window 

 
NTRIP Caster Open the “NTRIP Caster” sub-window 

 
NTRIP Server Open the “NTRIP Server” sub-window 

 Console  Open the “Console” sub-window 

 
Stop Play Stop log play 

 
Play Speed Select different rates for log play 

/  Start Play/Pause Play Start/pause log play 

 Play progress slider bar Play progress bar, and click to drag the progress bar 
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3 Common Operations 
 

3.1. Connect to Receiver 

 

Follow the below steps to connect the receiver to the QGNSS software utility: 

 

Step 1: Run the QGNSS tool. 

Step 2: Click the “Set Device Information” button on the tool bar to open the “Device Information” 

window. 

 

Figure 57: Open Serial Port Configuration 

 

Step 3: Select the module and serial port parameters, and then click the “OK” button. 

  

Figure 58: Serial Port Configuration Dialog 
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3.2. Console 

3.2.1. Data Matching 

Pressing the “Ctrl+F” shortcut key in “Com Tool” and “Protocol Package” will hide or show the search 

widget. 

 

Figure 59: Search Widget 

 

Data matching is executed by employing regular matching. For example, input “\$GNRMC” and then the 

matched strings “$GNRMC” will be highlighted. Then click  button, the right side of “Com Tool” 

sub-window will display the matched newline data. 

 

Figure 60: Com Tool Data Matching 

 

Multiple messages can be matched simultaneously by adding “|”, for example, “RMC|GGA”. 
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Figure 61: Multiple Messages Matching in Com Tool 

 

 

Figure 62: Multiple Messages Matching in Protocol Package 

 

 

1. Because characters like “$” and “*” are escape characters in regular expressions, you need to add “\” 

in front of them to prevent escape. For example, “$” in the regular expressions represents the end of 

the string. To match the “$”, use “\$”. Similarly, “*” is used to denote zero or more repetitions of the 

preceding subexpression. Thus, so to match the “*”, employ “\*”. 

2. The matching rule is to match by line. 

NOTE 
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3.2.2. Script Send 

Click the  button on the left column of “Com Tool” to pop up the “Script Send” window. 

 

Figure 63: Send Script 

 

Send one command at a time: 

1. Enter the command to be sent in the command box. 

2. Click the “Advance” button to configure the sending parameters in the pop-up menu, as shown in 

Figure 37: Script Console. 

3. Click  to send the command.  

 

Send enabled commands cyclically: 

1. Enter the commands to be sent in the command boxes one by one.  

2. Click the “Advance” button to configure the sending parameters in the pop-up menu, as shown in 

Figure 37: Script Console. 

3. Enter the number of cycles in the box after “Times” and the delay time (unit: ms) of each cycle in the 

box after “Delay”. 

4. Click  button, as showin in Figure 37: Script Console, to send the commands cyclically. If you 

want to end the command sending in advance click . 

 

3.2.3. Console Sub-Window Display 

“Com Tool”, “Protocol Package” and “Message Statistics” in "Console" are displayed horizontally. You 

can switch the position of the windows by dragging the window tab to another tab with the mouse. 
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Figure 64: Console Window Display 

 

Clicking on a non-tab area of the window, the “Move to Other View” tag pops up. Click on this tag can 

split the window into a new display. 

 

Figure 65: Console Window Splitting 

 

3.3. Log Play 

 

Steps to replay a recorded log file: 

Step 1: Click the “Start Play” button to open the play dialog box. 

  

Figure 66: Log Play 
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Step 2: Select the module and enter log file path, select “Default Mode” and then click the “OK” button. 

This mode allows the use of all functions. Or select “Specialized Analysis Mode” and then click 

the “OK” button. This mode provides overall log parsing for GNSS Log to display the entire curve. 

 

Figure 67: Select File – Default Mode 

 

Figure 68: Select File – Specialized Analysis Mode 

 

Step 3: Select the Read Rate (KB/s). 

 

Figure 69: Play Controller 

 

See Table 4: Description of Tool Bar Functions for the descriptions of above buttons. 
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3.4. Restart Receiver 

 

Choose a restart type and click the corresponding button in the tool bar to send the restart command to 

the receiver. For the description of these buttons, see Table 4: Description of Tool Bar Functions.  

 

Figure 70: Restart Receiver 

 

3.5. Configure Receiver 

 

Click “Configuration View” in the “View” tab drop-down menu to open “Configuration View” window. 

  

Figure 71: Open Configuration View 

 

Step 1: Select the parameters to be configured and click “Setting” button. 

Step 2: If the parameters support the query, click the “Query” button to query the configuration 

parameters. 
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Figure 72: Configuration View 

 

3.6. Download AGNSS Data from Server 

 

The QGNSS tool incorporates an AGNSS feature that enables the downloading of AGNSS data files from 

FTP server using two distinct approaches: “Online AGNSS” and “Offline AGNSS” data downloading. 

 

Figure 73: Open AGNSS Sub-Window 

 

3.6.1. Online AGNSS 

Click "Online" in the "AGNSS" drop-down menu of the "Tools" tab to open the "Online AGNSS" window. 

See Figure 73: Open AGNSS Sub-Window for details. 

 

Step 1: Select the check box before “UTC” to set the UTC time. 

1. Select the “Use System Time” check box to use the system time. 
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2. Enter the leap second time in the “Leap Second” field. 

3. Enter the time accuracy in the “Time Accuracy” field. 

 

Step 2: Select the “Position” check box to set the position via one of the methods below: 

 

⚫ Manually input Latitude, Longitude, Altitude and Accuracy 

⚫ Select the "Use Current Position" check box to use the current output position of the 

module 

 

Figure 74:Online AGNSS Sub-Window 

 

Step 3: Download the EPO file. 

1. Select the EPO files of the satellite systems that need to be downloaded 

2. Select the Cold/Warm/Hot start command as required 

3. Click  to start download the EPO file 
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Figure 75: Download EPO File 

 

3.6.2. Offline AGNSS 

Click "Offline" in the "AGNSS" drop-down menu of the "Tools" tab to open the "Offline AGNSS" window 

Then, select the EPO file of the satellite systems that need to be downloaded, and click  to start 

download the EPO file. 

 

Figure 76: Offline AGNSS Sub-Window 



 
                                                    GNSS Module Series 

 

QGNSS_User_Guide                                                                  58 / 68 
 
 
 

3.7. Build NTRIP System 

 

“Networked Transport of RTCM via Internet Protocol” (NTRIP) stands for an application level protocol 

streaming "Global Navigation Satellite System (GNSS)" data over the Internet. This section will overlook 

the NTRIP system supported by the QGNSS. Currently the QGNSS supports “NTRIP Caster”, “NTRIP 

Server” and “NTRIP Client” functions. For more detailed information on NTRIP, see document [1] RTK 

application note. 

 

3.7.1. NTRIP Caster 

The QGNSS tool has implemented the “NTRIP Caster” function, which can deploy “NTRIP Caster” 

through the QGNSS tool to receive and send GNSS data streams. The detailed steps are as follows: 

Step 1: Open the QGNSS tool, click the “NTRIP” option in the dropdown menu of “Tools”. Then click the 

“Caster” option, as shown in the figure below. 

 

Figure 77: Open NTRIP Caster 

 

Step 2: Enter the Address, Port, Username, and Password of “Caster”. If the Internet is required, make 

sure that the IP and ports can access to the Internet. 

Step 3: Check the checkbox next to the “Start/Stop” and start the “NTRIP Caster”, as shown below. 
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Figure 78: Start NTRIP Caster 

 

 

Quectel provides temporary “NTRIP Caster” to facilitate testing, the details are listed below: 

Address: 172.29.104.32 

Port: 7990  

Username: QL_NTRIP 

Password: 123456 

 

3.7.2. NTRIP Server 

Quectel not only has GNSS high-precision positioning modules, but also GNSS modules with original 

observation data, such as LC29H (BS) and LG69T (AS). This section introduces how to build “NTRIP 

Server” via the QGNSS using LC29H (BS) as the base station. 

Step 1: Open the QGNSS tool and connect the LC29H (BS) module. 

Step 2: Set the LC29H (BS) module as a Fixed mode or Survey-in mode.  

1. If you know the true coordinate where the base station mounted, you can set the LC29H (BS) 

to Fixed mode and send the coordinate in ECEF format. For example: 

Host Send: $PQTMCFGSVIN,W,2,0,0.0,-2472446.4619,4828304.1363,3343730.2653*34 

Module Response: $PQTMCFGSVIN,OK*70 

 

If you don’t know the true coordinate, you can set the LC29H (BS) to Survey-in mode which 

determines the receiver’s position by building a weighted mean of all valid 3D positioning 

solutions. For example: 

Host Send: $PQTMCFGSVIN,W,1,43200,15.0,0.0,0.0,0.0*13 

NOTE 
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Module Response: $PQTMCFGSVIN,OK*70 

 

2. Save the parameters: 

Host Send: $PQTMSAVEPAR*5A 

Module Response: $PQTMSAVEPAR,OK*72 

Step 3: Click the “NTRIP” in the dropdown menu of “Tools”. A secondary menu pops up, select “Server” 

to open the “NTRIP Server” window, as shown below. 

 

Figure 79: Open NTRIP Server 

 

Step 4: Enter Caster Address, Port, Username, Password and Mountpoint. Ensure Caster Address, Port, 

Username and Password are corresponded to the “NTRIP Caster” to be connected. Mountpoint 

is the mount point to distinguish different NTRIP Source, and the input value is determined by the 

user. “NTRIP Client” obtains the correction data through the corresponding mountpoint. 

Step 5: Check the checkbox next to the “Start/Stop” and start “NTRIP Server”, as shown in the figure 

below. After the “NTRIP Server” function is started, the original observation data of LC29H (BS) 

will be transmitted to “NTRIP Caster”. 
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Figure 80: Start NTRIP Server 

 

 

In Step 2, you can set a lower number of positioning in Survey-in mode, such as 300, facilitating a rapid 

examination of the RTK outcomes. Nonetheless, for the acquisition of an accurate base coordinate, it is 

advised to extend the number of positioning to a minimum of 43200. 

 

3.7.3. NTRIP Client 

The NTRIP is a gateway for GNSS modules to receive RTK corrections, which can effectively improve the 

positioning accuracy. Click “Client” in the “Tools” tab drop-down menu to open “NTRIP Client” window. 

 

Figure 81: Open NTRIP Client 

 

NOTE 
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3.7.3.1. NTRIP Client 

Use an NTRIP (V1.0) Client to connect to a standard “NTRIP Caster”, and follow these steps: 

 

Step 1: Enter the Address, Port, Username and Password as shown in Figure 83: NTRIP Client. Contact 

Quectel Technical Support to get the username and password if necessary. 

Step 2: Click “Update NTRIP source table” and wait for the server to return mount point information. 

Step 3: Select “NTRIP mount point”. 

Step 4: Enter “Request Interval”. 

Step 5: Tick the checkbox next to “Use manual position” and a window as shown in figure below pops 

up for entering the relevant position data and then tick “OK” butten. If the checkbox of “Use 

manual position” is unticked, the module will use the data of <Quality> parameter of the GGA 

message in Fixed mode. 

 

Figure 82: Manually Enter Position 

 

Step 6: Turn on the “Connect to Host” switch. 
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Figure 83: NTRIP Client 

 

Step 7: Check whether the GNSS module receives the differential correction data. After receiving the 

differential correction data, check whether the value of parameter <Quality> in the GGA 

messages is 4 (4 corresponds to the fixed RTK mode), as shown in figure below: 

  

Figure 84: Module Entering Fixed RTK Mode 
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3.7.3.2. Data Monitor 

Click “Monitor” to open the Data Monitor dialog box where you can view the differential correction data 

sent by the server. 

 

Figure 85: RTK Data Monitor 
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3.8. Firmware Update 

 

Connect to the receiver as explained in Chapter 3.1 Connect to Receiver. Click “Firmware Update” in the 

“Tools” tab drop-down menu to open “Firmware Update” window. 

  

Figure 86: Open Firmware Update 

 

Step 1: Click  to select the receiver firmware. 

Step 2: Click to select the baudrate. 

Step 3: Click  to start the firmware upgrade process and wait for the process to complete. 

Step 4: Reset module. 
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Figure 87: Firmware Update Process 

 

 

 

The steps for downloading the firmware via QGNSS tool may vary from module to module. See 

firmware upgrade guide of specific module for details. 

 

NOTE 
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4 Appendix References 
 

Table 5: Related Document 

 

Table 6: Terms and Abbreviations 

Abbreviation Description 

AGNSS Assisted GNSS 

BDS BDS Navigation Satellite System 

C/N0 Carrier-to-Noise-Density Ratio 

CEP Circular Error Probable 

DR Dead Reckoning 

EPH Ellipsoid Height 

Galileo Galileo Satellite Navigation System (EU) 

GLONASS Global Navigation Satellite System 

GNSS Global Navigation Satellite System 

GPS Global Positioning System 

IRNSS Indian Regional Navigation Satellite System (NavIC) 

KML Keyhole Markup Language 

MSL Mean Sea Level 

NTRIP Networked Transport of RTCM via Internet Protocol 

PRN  Pseudo Random Noise Code 

Document Name 

[1] Quectel_GNSS_RTK_Application_Note 
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Abbreviation Description 

QZSS Quasi-Zenith Satellite System 

RTK Real-time Kinematic 

SBAS Satellite-Based Augmentation System 

TTFF Time to First Fix 
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